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Introduction

Polar bear mother and baby

A baby polar bear rests on its mother in the Arctic snow.
early December.

© Howard G. Buffett

Polar bears give birth in late November or
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Requirements, Support, and Feedback

System:

« Mac OS X 10.3.9* or later, including Mac OS5 X
10.5 “Leopard”

Mac Model:

» iMac: 400 MHz or faster

» eMac/Mac mini: any

« PowerMac: 350 MHz or faster

« Intel Mac: any

« iBook: 500 MHz or faster

» PowerBook: 500 MHz or faster

Memory (RAM):

« 256 MB

Display:

« 1024x768, Millions of Colors

Video RAM:

» 8 MB (16 MB recommended)

Free Hard Disk Space:

« 1.2 GB (2.5 GB for full installation}
DVD-ROM drive

Internet connection required for accessing
online features**

Additional software:

« QuickTime 7.5 or later is recommended ™"

* Widgets require Mac 05 X 10.4 ar later
“+ (Ing year free subscription to "What's Online” area updates included.

Technical Support

If you experience any problems using World
Book, choose World Book Tech Support
from the Help menu to go to the World Book
Technical Support Web site. If you cannot
launch World Book, please visit The Software
MacKiev Technical Support Web site by going
to www.mackiev.com and following links to
Support.

Feedback

We'd love to hear from you! If you would like
to share your thoughts about World Book
with us including any suggestions you have
for future editions, choose Provide World
Book Feedback from the 2009 World Book
application menu and fill in the World Book

Feedback form on the Web page that appears.

** Tp get the latest version of QuickTime, visit www apple com/quickiime, or use the Software Update feature on your computer.
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Welcome to 2009 World Book

New Features in World Book

Webcam Collection

The next best thing to being half way across the
world is to travel through the magic of Webcams.
Software MacKiev has added editor-approved
Webcams to the 2009 edition of World Book.
Witness the construction of the world's largest
ferris wheel in Singapore. Look out for “Nessie”
an Loch Ness in the Scottish Highlands. See the
trains roll into Blumberg Station in southern
Germany and the gondoliers navigating the Grand
Canal in Venice.

‘4"’

Thousands of new articles and media

Each year the editors of the World Book 22-volume
paper-bound version of the encyclopedia, update
articles and add new ones. Those all are taken
word for word into the multimedia edition and for
2009 there are more than 4,000 new and updated
articles - from Angelina Jolie to Generation Y,
Organic food, and YouTube - as well as lots of
great new photographs, video clips, and more!
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New Features in World Book, Cont.

WORLD BOOK

Media Showcase Widget

Do you know where sitatungas lives? Find out with World
Book’s newest widget: Media Showcase. With more than

a thousand gorgeous images from World Book articles
gathered in a quiz format, you'll have fun learning about
people, places and living things across the planet while
viewing the best of World Book’s media collection. If you're
stumped, you can click through to the World Book article to
find the answer.

Content for iPod® and iPhone™

All World Book media content has been adapted
to play on Apple's latest iPods including the new
iPod Nano and iPod Touch. Exporting World Book
content to your iPod is just one click away so you
can take World Book’s media library with you.
Watch a documentary video clip on the Civil War
or listen to World Books rich music collection
anywhere you roam. As a bonus, our This Day

in History widget is also available as an iPhone
application that you can also play on an iPod
Touch.

Tip: To make the 2008 World Book icon

User Cuide Welcome o 2008 World Book

Installing and Registering
To install 2009 World Book:

1. Insert the 2009 World
Book Install DVD in your
DVD-ROM drive.

Welcome to Software MacKiev’s
2009 World Book Encyclopedial

2. Double-
click the
2009
World
Book
Installer icon and follow
the onscreen instructions.

Registration

If you register your copy of
2009 World Book, you will
get notifications of any free
product updates that we
release from time to time.
You can also sign up on

the registration page to get
email news about World Book
upgrades and special discounts, and to hear about new products from Software MacKiev.

If you are connected to the Internet when you install the product, you will be given a chance to
register online right away. Otherwise you can register later by choosing Register World Book from
the 2009 World Book application menu.

easy to find, drag it to the Dock or select the
*Add Warld Book icon to the Dock” checkbox )
during Installation. E @

e ———
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Chinese musicians

Chinese musicians play Western and Chinese instruments. In the group shown here, the girl on the
left is playing a cello, and her friends are playing traditional Chinese instruments.

World Book photo by Robert Borja
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World Book Home Screen

To launch World Book, double-click the 2009 World Book application icon, which you will find in
the 2009 World Book folder inside the main Applications folder on your hard disk. When World
Book opens, you see the Home Screen with the Search and Browse areas and videos and pictures
floating across the bottom.

Dictionary lust Listening
Click to find definitions in Click to explore Warld Book's music content and other
the Dictionary. See page 14. sounds by theme. See page 21.

Just Looking
Click to browse
through World
Book's content
for ideas. See
page 20.

Topics

Click to start
searching for the
information you
need. See pages
15 and 18.

JORLD BOOK

SEARCH BROWSE

Surf the Ages
Click to browse
imaginative

and historically
accurate websites
covering the past
5,500 years. See
page 25,

Time Frame
Click to search
for information
related to a
specific time.
See page 23.

What's Online
Click to access

World Book's World Book

extensive onling Trivia

functionality. See Click to open

page 24. the application
and test your
knowledge. See
page 30.

Media Thumbnails Stream Atlas Area Media Center

Click a floating media element to find out Click to start browsing Click to view all videos, animations,

more about it in the Media Center, Place your World Book's detailed pictures, and bubble views or to listen to

pointer over a media element to see its title.

(©12]

maps. See page 24 the sounds found in articles. See page 19.

I§ User Guide

Getting Started

World Book Main Screen

The World Book Main Screen has five main areas: the toolbar (including Navigation, Tool, and
Area icons), Tool Kit (including area-specific Tools, Search, Navigation Kit, and Dictionary),
Media Canister, main viewing area, and status area.

Navigation lcons: Click Back to
go back one screen at a time,
click Forward to advance one
screen, and click Home to go to
the Home Screen.
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Tool Icons: Click Theme to
choose an appearance theme
for World Book, click Sticky Note
to add a new sticky note, and
use Highlighter to highlight
parts of the text.
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Area Icons: Use these icons to
go to the Article, Media Center,
Atlas, Just Looking, Time Frame,
Surf the Ages, and What's
Online areas.

Tool Kit: Click these icons
to open area-specific Tools,
search, Navigation Kit, and
Dictionary.

Media Canister: Displays the
media available in articles,
multiview illustrations, and
maps.

Main Viewing Area: The area
where you view all World Book
articles, media, and so on

Status Area: When you position
your pointer over a thumbnail,

a brief description of it appears
in this area.




e ————— —

Chapter 1 2009 Waorld Book @ @ User Guide Gelting Started

World Book Tool Kit Using the Search Tools

There are four icons on the left side of the World Book screen which you can click to open Click the Search icon in the Tool Kit, and then click By Topic, By Word, or By Letter. Type your
the four most often used toolsets. Click any of the four icons to hide or show the Tool Kit search term in the field and press Return to begin your search. The closest match is highlighted
area. in the search results list and appears in the main viewing area. Double-click any other result
in the list to open the corresponding item.
Area-Specific Tool Icon: The topmost Tool Kit icon changes to match the area
you are in. When you select an area of World Book to visit, the appropriate area-
specific toolset opens automatically. For example when you go to the Article
area, the Article Tools area will appear.

Additional Terms Start Search First Letter
Click to start a new Click the first letter of the word
you want to find.

Folder With Articles
Double-click a folder to Enter additional
open a list of articles. search terms. search.

= = - i : = american painting tmeline
A Navigation Kit: Click this icon to open the Navigation Kit, g.g.,,m:: painting timeling I
which includes the following tools: 8 The City Rises by Umberto
Bocciont
[TT] Famous artists and their
5
What painters paint A
History: 8 sunday Afternoon an the E::xwm
Go to previously visited places in World Book. Click the Islind of La Grande jau o Sk abea iy
disclosure triangle next to a date in the History list to view a “ : o bt il S
list of places visited that day. B8 Mokl |y Wik ] S
Kooning [5) Flower (Cross-poltination)
: Religious subjects gl Frisch, Kart von
Sticky Notes: i The Madonna and Child with | [ nses
View and organize your sticky notes. For more information, Chancedlor Rolin

14

Search: Click to open the Search area, where you can search for an
article or a media resource by topic, word, or letter,

see "Using Sticky Motes” on page 26.

Categories:

All World Book articles are divided Into nine categories
(Geography, History, Humanities, Industry & Technology,
Life Science, Life Science | Plants, Physical Science & Math,
Recreation, and 5Social Science). Select a category to explore
the articles In it.

Dictionary: Click the icon and enter the ward you want to look
up, Click the Speaker icon to start or stop World Book reading
the definition. Use the Related Entries pop-up menu to search for
exact matches for your search term, similar words, or the search
term found in examples or in definitions.

Landseapes and seascapes

Saill-Hife paintings

Histary paintings

L& Napalean |

Mythology paintings

Social expression

B The Executions of 3rd May, 3
1808 by Francisco Goys -

Drag-and-Drop Tip: Drag any word to the Dictionary icon or double-
click it to see its definition in the Dictionary.

[ Insect (Wings)
1l nsect Family life)

[isl Poflen (Cross-pollination]

“See also”
Double-click a "see
also” item to start a
new search.

Set Proximity

Choose to search for multiple terms within
a sentence, a paragraph, or an article, or
within a certain number of words.

Select a Media Type
Click to narrow your
search to a particular
media type or types.
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Astronaut Edward H. White Il walks in space

The first U.S. astronaut to walk in space was Edward H. White Il on June 3, 1965. A 26-foot (8-meter)
cord linked White to the Gemini 4 spacecraft during the spacewalk. He controlled his movements in
space by using a handheld rocket gun filled with gas.

NASA
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: Reading Articles

The Article area of World Book is where you read articles, and view related information. To
open an article from the Home Screen, click the Topics icon, or click the Article icon on the

:‘ :.-..- toolbar, if you are in another World Book area.
|

| ke Article Tools
G Click to hide or show Article
I! Tools.

Related Info. |

|

|
Outlines:
Click this control to see the article contents
by headings. Click any item in this outline
and the article will automatically scroll to
that section.

Related Info:

Click this control for a list of related World

Book articles and online resources, Including

websites selected by World Book editors.

An article may contain special items:

. Tables: Open tables by clicking the
= Tables icon.

Sound: Click the Sound icon to hear
related sounds.

Warner Collection sound clip: Click
to hear sound clips from the Warner/
Rhine Music Collection.

Timeline: Click the Timeline icon

% to view a related chronology. When
warking with timelines, you will see the
Timeline Tools icon in the Tool Kit,

Media Canister

Click to see all media elements related to the article in view.

Click any item to move to the section of the article containing the
corresponding thumbnail, or double-click an jtem to open it directly.

———
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Media lcons

You can jump to the full-size version of any
picture, map, movie, animation, table, timeline,
or bubble view by double-clicking its icon.

Media Thumbnail
Click to view the
media element in
the Media Center.

User Guide Using World Book

Viewing Media

All videos, animations, pictures, and bubble views appear in the Media Center. All the
sounds found in articles can also be played here. If you haven't installed the Media Contents
while installing World Book, you will have three panes in the Media Tools area; Current, All
Installed and Media on DVD.

; Media Tools
Click ta hide or show Media

Tools

[_ Cumrent - All instalied “Media on MD"]

Current: Click to browse all the media
associated with the last article, Time Frame,
ar Just Looking search that was in view
before you moved to the Media Center.

All Installed: Click to browse the media
that is installed on your hard disk.

Media on DVD: Click to browse the media
that is stored on the Media DVD. (The
Media DVD contains all the animations and
some of the longer video clips.)

8 P 364 - i P

Media Type

Select to search by media type. You can
select several media types by holding
down the Shift or Command key while
clicking the icons.

Results
Double-click an item to view it.

Export to iTunes Toggle Movie Size Related Article
Click to export Click to make a Click to go
a video clip or video or animation to the article

animation to iTunes. twice as large or associated
You can then add it revert to its normal with the media

Tip: To install all the media from

to your iPod. size. element in view.
the DVD on your hard disk, choose
Install Media Contents from the —
World Book application menu. |_1 9@

——
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Just Looking

ﬁ Just Looking enables you to browse through the content of World Book for ideas, much like

¢ flipping through the pages of the paper edition. However, Just Looking is also a powerful
tool that you can use to search for World Book resources by theme or by category and type
of resource.

Clear Search
Just Looking Device Click to clear Click to search and
Use the device to search for resources. the screen, display the results.

By Theme

Click to browse through the rich Warld
Book media collection by selecting
Interesting subjects. Choose items from
the Themes and Subjects pop-up menus
to guide your tour.

By Category

Click to browse through eight World
Book categories. Choose items from the
Categories and Content pop-up menus
for mare specific browsing.

Audio Icons

‘))) Click this icon to play the sound
without leaving the Just Looking
area,

Ig_ﬂ‘ Click a thumbnail with this icon to
go to the Media Center, and then
click the icon to enjoy the sound.

Q Click a thumbnail with this icon to

M hear a Warner Music sound clip in the

Media Center.

Advanced Search Thumbnails
Click the bottom of the device to open an Advanced Click a thumbnail
Search drawer. Type a few letters to filter the media list Lo view it in the

and then click an item in the list to place it on the screen.  corresponding area.

LE User Guide

Using World Book

Just Listening

' 5 Just Listening enables you to explore the World Boek music content and other sounds by
@ theme while corresponding media elements float by on the Home Screen “waterstream.”
Click the Just Listening icon on the Home Screen to open the Just Listening player.

Music Sampler
Classical Music
Opera
Jazz
Rock Music
Country Music
Musical Instruments
Mational Anthems
Songs from Europe
African Music
Asian Music

Middle Eastern Music

Latin American Music
Music from the islands
Bird Calls
Animal Noises
Sounds of Nature
Speeches and Addresses
Poetry

Shakespeare

lict Licte

Hmnsi Go to Sound

v Play : Click to open the
CLerer L sound in the Media

Center.

Go to Picture
Click a picture
to apen it in the
Media Center.

Set Volume
Drag the slider to
adjust the volume.

Export to iTunes
Click to export a
sound to iTunes,

Go Back Play/Stop Go Forward
Go to the Click to start or Go 1o the next
previous sound. stop playback. sound.

Filo
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Exploring Maps

states, provinces, and cities.

Atlas Tools
Click to hide or show Atlas Tools.

Map Browse _ Related info

Map Search: Click this tab and type a few
jetters to filter the map list. Double-click an
item in the list or complete typing the location
and press the Return key to start your search.

Map Browse: Click this tab and navigate
through the maps by clicking the disclosure
triangles to reveal continents and countries,

Related Info: Click this tab to view a list of
all World Book resources linked to the map
currently in view.

Results
Double-click an item to open it.

Map Overlays:

Click to see map overlays that may include population density, climate, average temperatures, annual
precipitation, agriculture and fishing, mining and manufacturing, terrain, and economy.

g

\@@

@ The Atlas opens with a map of the world. Begin your tour of World Book maps by clicking any
continent label. Continue clicking to view progressively more detailed maps, showing countries,

Zoom Out Related Article
Click to move to progressively Click to go to the

smaller-scale maps containing
the ariginally selected map.

article related to the
map in view.

Drag-and-Drop Tip: You can drag a place name from any area of World Book
or from any place in your system to the Atlas icon on the tooibar to start a map
search. The Atlas area open automatically and displays the closest matching
map. All of the maps in the World Book Atlas can be copled by dragging them ta
an open document window in any application that accepts graphics.

@ Lser Guide

Llsing Waorld Book

Searching by Time Frames

Use Time Frame to locate information related to a specific year, decade, century,
millennium, or era. Time Frame search results are displayed as thumbnails, making it easier

to pick out the information that interests you.

Time Frame Tools
Click to hide or show Time

Frame Tools.

(

Era

Click the Era tab and select one of the preset
wras, such as The Cold War or The American
ftevolution.

Time Period

Click this tab and enter a specific Time
Frame, measured In years, decades,
centuries, or millennia. To focus your search,
choose a category from the Category pop-
up menu. Time Frame will assume you are
entering years that are A.D. {default) unless
you select B.C. If you select a period other
than Year after typing a date, the date will
be reset to reflect the selected time period.
(For example, if you type 1952, and select
becade, and then start your search, the date
will be reset to 1950.)

Filter List

Type to filter your search
results. Double-click an item
in the list to open it.

Start Search
Click the Search button or press
Return to begin your search.

Thumbnails
Click any thumbnail to go to the corresponding

article or media element. Position your pointer over
a thumbnail to view a description of it in the Status

area at the bottom of the screen.

€
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Looking Online

The What's Online area gives you access to World Book's extensive Internet functionality.
Click the What's Online icon on the toolbar and then click any Online Tool to select it.

o Update Now, Click to download World Book updates for articles, The Month in Brief, and Web sites and Webcams
- links.

Article Updates. Click to view all the article updates you have downloaded. Double-click any article title to view
the article update text. To see the whole article and its update in the Article area, double-click the update text.

The Month in Brief. Click to apen a calendar with summaries of the major news events of each day of the month.
Click a date on the calendar to view the top news for that date.

Web Sites. Click to explore websites that have been reviewed and approved by World Book editors. Type search
terms in the entry fields (for example, *Apple" and “Computer") and click Go to start your search.

Webcams. Click to watch real-time images of major world attractions, including palaces, cathedrals, monuments,
parks, wilderness areas, resorts, and amusement parks. All Webcams are organized into categories. Select a
category to browse a list of Webcams. Webcam images are automatically displayed in the Meadia Center window.

Back in Time. Click to download historical articles from World Book's chronological annotated anline archives.
Choose a topic from the drop-down menu and then click a link to start downloading the Back in Time article,

Special Reports. Click to browse the Special Reports collection, prepared by World Book editors to supplement
the Encyclopedia articles. Select a category and click a link to download the corresponding report.

World Book on the Web. Click to go to the Warld Book website, where you can find educational resources for
parents, students, and teachers.

Online Subscription: World Book includes a free one-year subscription for online access to the What's Online features. After the
free period |5 over, you will be able to renew your subscription for an annual fee. Downloadable updates are posted regularly and
stored in the /Library/Application Support/2009 World Book/Download folder so that you can access them easily whenever you
need,

Notification of Online Updates: World Book automatically checks for updates every time you open it and are connected to the
Internet — and once a day for as long as it is running. If an update is found, the World Book icon in the Dock starts to spin and a
dialog appears suggesting that you use Update Now to download the update. Click Update Now to automatically download any
new article updates and updates to Month in Brief and Web Sites.

G

D Lser Guide Using World Book

Surfing the Ages

Surf the Ages is an imaginative and historically accurate look at the past 5,500 years. Click
Q Surf the Ages on the Home Screen or click the Surf icon on the toolbar to get started. Each

time period, from 3500 B.C. to the 20th century A.D., has its own home page with links to

other imaginary websites from that era. You can visit them using the offline browser built
into this edition of World Book,

surf the Ages Functions: Click Ancient Times, Middle Ages, or Modern Times on the Surf the Ages Home Screen to begin surfing.
Ihen choose from the four or five time periods for each age to view century home pages full of web features such as e-zines,
want ads, bookstores, and other types of imaginary website.

Browse Middle Ages
Click to explore the
world of 1000 to
1500 A.D.

View Ancient Times
Click to browse
wehsites covering
3500 B.C. to the

A8 AL, View Modern Times

Click to discover
more about the last
500 years,

View From today

Click to get a modern perspective on a featured
event, person, or idea, and to get links to World Book
articles, book lists, and real websites,

(B24] 258]
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Using Sticky Notes

| Use sticky notes to mark important information for later use. Sticky nates can be placed in
[ Fp’ articles, in the Media Center, or in the Atlas.

Sticky Notes in the Navigation Kit Create Sticky Notes Edit Sticky Notes

Click this icon and then click the Sticky Click to place a sticky note. Click and Click the title to edit it. Click
Nates tab to view and organize all your hold the icon to choose a new color inside the sticky note to edit
sticky notes. for your sticky notes. its content.

Create new folder

Click this icon to add an
organizing folder. Drag your sticky
notes into folders to group them.

Delete
Click this icon to delete selected
sticky notes or folders,

Change color
Click this icon to change a
selected sticky note’s color.

Share Sticky Notes

You can share sticky notes by selecting the
“Share my Sticky Notes™ checkbox in the
Sharing pane of World Book Preferences,
where you can also choose to have World Book
look for the shared sticky notes of others.

Print Sticky Notes: To print sticky notes,
choose Print Sticky Notes from the Sticky
Notes menu,

Sticky Notes Marker

Sticky notes you have placed in the Media Center are
marked in the list according to the type of media
element to which they are attached.

Drag-and-Drop Tip: You can copy the content of a closed sticky

note into Notepad or TextEdit by dragging the sticky note icon to

an open document window. You can also drag a folder full of sticky

@ notes to Notepad for easier editing.

Llser Guide

Using Word Bool

General Pane: Change Home Screen settings, have World Book retain
the items in your History list, and set the number of steps for Back and
Forward navigation,

Appearance Pane: Change the look of World Book, specify article text size,
and set the default transparency of sticky notes,

Window Pane: Set World Book to open its contents in an unlimited number
of resizable windows and retain the size and position of windows after
quitting.

Special Effects Pane: Set bubble view options and open World Book
Screen Saver preferences.

Dictionary Pane: Change the default settings for the built-in World Book
Dictionary.

Sharing Pane: Turn sticky notes sharing on or off and specify additonal
sharing settings.

Speech Pane: Specify Speech Capabilities settings to work with World Book
using voice commands.

Updates Pane: Turn on automatic update options and choose a notification
method.

The World Book Preferences dialog contains eight panes — General, Appearance, Windo_w,
Special Effects, Dictionary, Sharing, Speech, and Updates — that you can use to customize
your World Book settings. Click the corresponding icon to open the pane you need.
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Embossing
Leather is embossed with a special punch.

World Book photo by Ralph Brunke
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World Book Trivia Challenge

World Book Trivia Challenge contains 74 topics covering a wide variety of subjects including

history, literature, space exploration, and much more. Each World Book Trivia Challenge topic

has been specially compiled to make the questions both interesting and informative. Launch

World Book Trivia by choosing it from the Tools menu in World Book or by double-clicking the
World Book Trivia icon located in the 2009 World Book folder.

Select a Category
Click to select a
category you are
interested in.

Select a Topic

Click to select a topic. You
can select several topics by
Command-clicking them.
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Start
Click to begin
the challenge.

Es0]

Select Answer
Click to select the
answer you think is
correct.

Go to Article

Click to view the
corresponding World Book
Article.

WORLD BOOK

Caicgory:  LLS. History
Topic: New Yok City

In whit year did Hrookhyn and severn] communities in what becarne the Bronx,
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Scoring Home Next
Shows the number of correctly Click to Click to
answered questions, the current  return to proceed to
question, and the total number the main the next
of gquestions in the topic. screen, guestion.
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User Guide Using Warkd Book Applications
Working With Notepad
“FE World Book Notepad is a simple and customizable word processing application included with

Format Document: Notepad includes number of options,

such as inserting headers and footers, page breaks, and page

numbering, that allow you to create professional-looking

doguments,

Change Fonts. Click this icon to select any
‘A font available on your computer from the
WYSIWYG fonts list.

@ View Statistics. Click this icon to count
the number of pages, words, characters,
paragraphs, and lines in your document.

i, Search in World Book Articles. Select text

I % in a Notepad document and click this icon to

= search for information related to it in all World
Book articles.

Look up Words. Select a word or words and
click this icon to search for definitions in the
freestanding World Book Dictionary.

Customize the Toolbar. Click this icon to
open the Customize Toolbar sheet. Drag
contrels from the sheet to the toolbar to add
them, or drag them off the toolbar to remove
them. To reset the usual Notepad toalbar
arrangement, drag the default set of controls
to the toolbar.

World Book. Notepad allows you to create documents using text and graphics from World
Book with ease. Launch Notepad by choosing it from the Tools menu of the main World Book
application or by double-clicking the Notepad icon in the 2009 World Book folder.

Import Images: Choose Import Image from the File menu to
insert a photograph or other graphic image. In the dialog that

appears, select the graphic file you want to import.

FERnCE i & counitry in western Europe, Bt
Europe's thied largest country In area. Only Russia
and Ukraing Fave more and.

France's cacita #nd
Inrgest chy Is Pari, one of
the warld's great cities. Fer Pundreds of years, Paris
has baer & wirld center of art and learning. Many
‘great artists have produced thair ndst Masterpiaces
thare. Every year, millons of tourists visit such
famous the wl

\

rs Dama, the Efel Tower, snd
e Louvre-cne of the Brpest an Museums in the workd.

Thare is muich mane tn France thas Faris, howeser, The
anow-capped Alps in (e southeastem cart of the cauntry form
the Eordér betwesn France and Itafy. Surny beaches and stoep

N Drag-and-Drop Tip: You can drag selected text from Waorld Book

articles, captions, tables, and from the Dictionary into any open Notepad
document. You can also drag most media elements such as maps,

pictures, and timelines,
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World Book Dictionary

Use World Book Dictionary to look up any word you enter. To launch World Book Dictionary,
choose World Book Dictionary from the Tools menu in World Book, or double-click the
World Book Dictionary icon in the 2009 World Book folder,

4p

Go Back or Forward, Click

to revisit the definition of a
previous search item or to go
forward after clicking the back
button.

Start or Stop Reading. Click to
start or stop the reading of the
definition.

Search in World Book Articles.
Click to find selected text In
World Book articles.

View History List. Click the
icon to open a drawer where
you can find words you have
looked up before.

Perform an Action. Use this
pop-up menu to perform an
action with selected words or to
open the Preferences window,
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A, {Meteatnbogy. )  wined having a vedocity of T4 or
mane mides per bour o the Hoalon sale, force 123
b, 8 tropical eyclnis origimming wsially in the Wes

Irdies. atten acoompanied by violet shusderssarnis
3. o warm with o vinlenr wisd and, unaally, very

i
A (Figunarive. v a sadden, vislent oubure

E1 o harviviciy i rhes

hurrscane varning

Search
Type a word to
search for.

View Definition

The definition of the
search word. You can
double-click any word
in this area to see its
definition.

View Related Words
Choose related entries
for the found word.

List of Related Items
Click a search result to
see its definition,

" - - =
If Speech Recognition is turned on in System Preferences, you can work with the Dictiona

commands:

“Look up in the dictionary”
“Pronounce please”

“Definition please”

*Go back”

| “Go forward”

Goes one step back.

Goes one step forward.

Opens a selected word in the dictionary.
Pronounces the word displayed in the front window.

Reads the definition of the word displayed in the front window.

ry using the following speakable
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World Book Atlas

Use World Book Atlas to find the distance between two locations. To launch World Book Atlas,
double-click the World Book Atlas icon in the 2009 World Book folder.

B =a)

@@Loog

Change the View

Switch between the split-view
globe, full-view globe, or
full-view flat map.

Rotate the View

Click to rotate the globe to
the left or right or to stop
rotating.

View Day/Night
Click to turn the day/night
view on or off.

View Grid
Click to turn the grid on
ar off,

Change Settings
Click to open the drawer and
change settings.

Get Help

Click to open help, where you
can find detailed information
on using the Atlas.

Print the View

Click to print the current view
of the globe and map view
with locations and distance
Information.

Locations

Type two locations in the fields to find the distance between them.

Distance
The distance between
the specified locations.

Tip: As you move your pointer over T.l_':e Navigation map, you will see
the location's latitude and [ongitude displayed In the Location field. This
helps you find an exact location on the map. Click when you find the

place you want.

Navigation Map
Click the map to set
a custom location.

Globe
Drag to rotate
the globe.
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Foucault pendulum

A Foucault pendulum shows the rotation of the earth. It swings back and forth in the same plane, but
the earth’s rotation makes the pendulum appear to change its path gradually.

Waorld Book photo by Dan Miller
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This Day In History Widget

B Shows significant events in history that took place on the current date or any selected date.
(gs,j It appears as a widget on your Mac (Mac OS X 10.4 or later is required) and can also run on

an iPhone or iPod Touch.

View Link

Click any link in an event
description to open the
corresponding World Book article.

|
Go to Other Events ! .
Click the arrows to see other | Iof 4
events that took place on o o
this day. e S T e A

View Info
Click the Info button to
change the date.

@ Usar Ciside

Lising World Book Widgets

World Book Librarian™ Widget

for maps in the World Book Atlas area. Moreover, you can use Librarian to find a word

E Using the Librarian widget, you can immediately search for articles in World Book and search

definition in the free-standing World Book Dictionary.

Search in Encyclopedia
Click 1o search for a
matching World Book
topic.

Start search
Type a search term and
press Return.

xX
<
4

Look in Atlas

Click to search for a
matching map in the Atlas
area.

Look in Dictionary
Click to search |n the
freestanding World
Book Dictionary.
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World Book Media Showcase Widget World Book Trivia Daily Widget

This widget is a new quiz widget with 1000 questions based on World Book media elements. mm=== This widget contains hundreds of questions that cover a wide variety of topics from history
Each question comes with a picture or map that may help you get the right answer. The = and literature to sports and space exploration allowing you to match your wits against World
quiz includes questions on a variety of topics: from history and geography to literature and e  BOOk and maybe learn something new along the way. The questions appear randomly.
architecture.

Using Waorld Book Widgets

WORLD BOOK?® Trivi

Category: U.S. History

Topie: Slavery in the United States

What LLS. colony was established in Africa in 1822 by the
Amerienn Colonization Society as a solution to the “the
e problem?" The society offered to transport free blacks

What U.S. colony was established in Africa in 1822 by the
American Colonization Society as a solution to the “the
race problem?" The society offered to transport free blacks

on i voluntary basis to this. on a voluntary basis to this.
Swaziland “Liberia" was correct.

¥ Liberia
Chad

Colony, which later became first self-govemning black
=~ republic in Africa

See Answer!

Click this button to
find out or check the
answer to the guestion
displayed.

Go to the World Book Article @ |

Select Answer Answer
Click to select the Click to check Click to view the

answer you think is if the answer is corresponding World Book
cofrect. correct. Article.

Go to Article Another Question
Click to proceed to

the next question,

Another Question
This button takes you
to the next question.
All questions appear in
random order.

Unification of East and West Germany

Unification of East Germany and West Cermany took plack on Oct
3. 1990. Millions of Cermans celebrated throughout the country,
including these people at Berlin's Brandenburg Cate.

Look Up in World Book.
This button iImmediately
opens the World Book B el et
Media Center window with [ Look Up in World Book ﬁii
the corresponding picture e
and its caption.
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Warning
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